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Polos Creativos 
1. ¿Qué es un Podcast?

Para saber crear un podcast debes saber primero en 
qué consiste este tipo de contenido o de 
comunicación online. El podcast es como la radio, 
pero es contenido bajo demanda y puede 
escucharse cuando el oyente lo desee. Su formato 
tiene una alta potencia de comunicación, puede 
transmitir información, educación, entretenimiento y 
más. No existen límites para la creatividad.
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1. ¿Qué es un Podcast?

Hoy en día se vive muy rápido y apenas se dispone de 
tiempo libre. Los podcast se crean para ser escuchados, y 
esto facilita que una persona pueda acceder al contenido 
mientras realiza otro cualquier acción rutinaria o practica 
deporte.

Este formato es muy práctico y algunos profesores se 
inclinan por él para sus clases.
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Polos Creativos 
1. ¿Qué es un Podcast?

Ventajas del Podcast en educación:
● Descubrir la creatividad, desarrollar 

habilidades.
● Puede fomentar un espíritu de 

comunidad.
● Permite mejorar la labor escolar y el 

desarrollo académico.
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1. ¿Qué es un Podcast?

Historia del Podcast

Antiguamente, solo se podía escuchar contenido al visitar 
el sitio web de los proveedores y dar play o descargarlo. El 
13 de agosto de 2004, cuando Adam Curry, un empresario 
y famoso videojockey de MTV, creó una forma automática 
para que ese contenido llegará hasta los consumidores: 
los agregadores de podcast. Así funciona hasta el día de 
hoy.
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2. Características de un Podcast de calidad

1.Un objetivo claro.

2.Una buena estrategia de Marketing.

3.Un buen guion.

4.Una buena locución.

5.Técnica (grabación y edición).
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3. Tipos de Podcast

1. Podcast de entretenimiento, son los más habituales.

2. Podcast de información.

3. Podcasts de formación, cuentan con un enfoque 
pedagógico, resolviendo dudas y ofreciendo claridad sobre 
un tema específico.

4. Podcasts de persuasión: son de los mas escasos. El objetivo 
es inculcar una idea (religiosa o política por ejemplo).
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4. Cómo usan las personas los Podcasts

Las personas interesadas siguen el lanzamiento de cada 
nuevo episodio desde su teléfono u ordenador de forma 
automática, así pueden escucharlo desde la aplicación del 
teléfono o descargarlo.

Algunos ejemplos de agregadores de podcast son:

Android: Google Podcasts, Podcast & Radio Addict, Spotify...

Iphone: Apple Podcasts, WeCast, Spotify...

Polos Creativos 
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5. ¿Cómo hacer un Podcast?
● Elige un tema

En primer lugar hay que escoger un tema del que hablar. 
No se trata de compartir conocimiento sin más, es más 
interesante centrarse en un tema y desgranarlo poco a 
poco para que cada podcast sea valioso..

No es conveniente abordar muchos temas en un solo 
podcast. Es mejor utilizas varios archivos y clasificarlos 
por categorías.
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5. ¿Cómo hacer un Podcast?

● Define los participantes

El algún momento puede ser interesante 
invitar a personas de expertas para que 
participen contigo y compartan sus 
conocimientos.

En estas ocasiones puedes elaborar el 
podcast en formato debate, entrevista o 
como una clase magistral.
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5. ¿Cómo hacer un Podcast?

● Planifica el contenido

Es conveniente que antes de grabar te prepares una 
escaleta o un guion muy sencillo de cómo vas a abordar la 
sesión. Nadie está a salvo de quedarse en blanco.

En el guion debes anotar información como datos difíciles 
de memorizar como: nombres de instituciones, autores o 
libros, estadísticas, etc. Además debe incluir un esquema 
sencillo lo lista de control de los temas principales a tratar.
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5. ¿Cómo hacer un Podcast?

● Guion. Ejemplo
➔ Cabecera con indicativo. Anuncio inicial.
➔ Presentación de los locutores.
➔ Mencionar la fecha de publicación y el tema del podcast.
➔ Rápida introducción del tema para enganchar al público.
➔ Anuncio transitorio para informar el inicio del programa.
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5. ¿Cómo hacer un Podcast?

● Guion. Ejemplo
➔ Primeros avisos e invitación a la llamada de acción.
➔ Hablar sobre todos los puntos de la lista de control.
➔ Preparación para el cierre.
➔ Anuncio transitorio rápido para informar la conclusión del 

programa.
➔ Últimos avisos e invitación a la llamada de acción.
➔ Cierre.
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5. ¿Cómo hacer un Podcast?

● Gestiona el tiempo

Establece muy bien los límites de tiempo. Analiza cada 
programa y comprueba su duración, hay de dedicar el 
tiempo adecuado a cada historia y no pasarse ni 
quedarte corto.
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5. ¿Cómo hacer un Podcast?
● Preparación vocal

Como la comunicación se hará mediante un archivo de 
audio, los usuarios deben entenderte a la perfección.

Es importante que la dicción de todos los participantes 
sea impecable. También es importante regular el tono de 
voz correctamente.

Hay que evitar hablar muy rápido o muy despacio e 
intentar hacerlo con fluidez, seguridad y, sobre todo, 
tranquilidad.

Polos Creativos 
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5. ¿Cómo hacer un Podcast?
● Feedback

Pide feedback a tus colaboradores y audiencia para 
que puedas alcanzar el equilibrio adecuado.
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5. ¿Cómo hacer un Podcast?
● Grabación y edición de audio

Estos aspectos se ven con detalle en el siguiente punto 
de esta presentación.
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5. ¿Cómo hacer un Podcast?
● Divulga el podcast

Hay multitud de plataformas y canales para la 
divulgación de este tipo de contenidos (SoundCloud, 
Spotify, Google Podcast, YouTube…).

En nuestro caso la opción preferente será el aula 
virtual.

Polos Creativos 

19



6. Grabación y edición. Conceptos previos

Frecuencia de muestreo: es el número de muestras por 
unidad de tiempo que se toman de una señal continua 
para producir una señal discreta. Su término inglés es 
sampling y es un proceso básico en la transformación del 
sonido analógico en sonido digital.

Simplificando mucho, a mayor cantidad de frecuencia de 
muestreo la captura del sonido será más precisa y, en 
consecuencia, el sonido digital será de mayor calidad pero 
los archivos resultantes tendrán un mayor peso.
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6. Grabación y edición. Conceptos previos

Frecuencia de muestreo.
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6. Grabación y edición. Conceptos previos

Frecuencia de muestreo.

El teorema de Nyquist determina que se puede reproducir 
de manera exacta una onda si la frecuencia de muestreo 
es, como mínimo, el doble de la más alta de la señal a 
digitalizar.

En el caso del oído humano esta frecuencia corresponde a 
20.000 Hz por lo tanto la frecuencia de muestreo más 
adecuada será de 40.000 Hz. Es común aumentar esta 
frecuencia a 44.100Hz, 48.000Hz o más.
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6. Grabación y edición. Conceptos previos

Frecuencia de muestreo.

Frecuencias de muestreo típicas
● 8.000 muestras/s Teléfonos, voz humana. Hasta 3,5 kHz.
● 22.050 muestras/s Radio. Hasta 10 kHz.
● 44.100 muestras/s CD (MP3). Hasta 20 kHz.
● 48.000 muestras/s Televisión digital, DVD, películas, 

audio profesional.
● 96.000 o 192.400 muestras/s audio de alta definición.
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6. Grabación y edición. Conceptos previos

Resolución: es el número de bits (0/1) que componen 
cada muestra. Es habitual trabajar con 16 bits aunque 
se puede hacer también con 24 o con 32. Cada muestra 
tendrá 2n valores posibles dónde n es la resolución de un 
audio utilizada.

Nº de canales: determinaremos si la grabación se realiza 
en un canal (mono) o en dos (estéreo).
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6. Grabación y edición. Conceptos previos

BitRate: es el siguiente producto:

Un CD de audio 44100 Hz * 16 Bits * 2 canales ≈ 1.400 
Kbps.

Nota: El CD es un formato sin compresión (cda), si usamos 
uno con compresión (como *.mp3)  tendremos que tener en 
cuenta eso a la hora de establecer el bitrate (a partir de 128 
Kbps se considera la calidad del mp3 indistinguible del CD).

Polos Creativos 
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6. Grabación y edición.

Es el momento de iniciar la grabación. Por lo tanto, los 
participantes deben estar en un ambiente cómodo y 
silencioso. Es muy importante crear una sala con una 
buena acústica, ya que además de garantizar un audio de 
excelente calidad, también ahorra esfuerzos a la hora de 
editar el contenido para minimizar ruidos.

No creas que con un buen micrófono no será necesario 
tener una buena acústica, ya que, si ese es el caso, no 
servirá de nada tener un micrófono de excelente calidad.
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6. Grabación y edición.

Hay muchas cosas que se pueden hacer para que un 
podcast suene mejor:

● Insonorizar el espacio de grabación.
● Utilizar micrófonos dinámicos y mesa de mezclas.
● Ecualizar correctamente el sonido y la voz.
● Mejorar el sonido en edición.

Polos Creativos 
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6. Grabación y edición. Preparación del equipo
● Nuestro equipo

Polos Creativos 
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6. Grabación y edición. Preparación del equipo
● Puesta en marcha

➔ Encendemos ordenador
➔ Encendemos mesa de mezclas, debemos tener 

cuidado de no activar por error la alimentación 
fantasma.

➔ Encendemos el distribuidor de señal para los 
auriculares.

*Si hubiera altavoces conectados encendemos estos también, previamente 
debemos asegurarnos de tener los niveles de señal a 0.
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6. Grabación y edición. Preparación del equipo
● Puesta en marcha
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6. Grabación y edición. Preparación del equipo
● Puesta en marcha
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6. Grabación y edición. Preparación del equipo
● Prueba y configuración.

El siguiente paso consiste en probar microfonía, 
auriculares, software de grabación (Audacity), 
reproductor de audio (PC, sólo si es necesario).

Se trata de intentar ajustar los distintos niveles de 
señal con el objetivo de obtener el mejor resultado 
posible. Para probar y poder configurar y ajustar los 
niveles de señal necesitamos conocer mínimamente 
nuestra mesa de mezclas.
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6. Grabación y edición. Preparación del equipo
● Mesa de mezclas.
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6. Grabación y edición. Preparación del equipo
● Mesa de mezclas. Canal de entrada
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6. Grabación y edición. Preparación del equipo
● Mesa de mezclas. Canal de entrada

➔ Entradas de audio (XLR micro / Jack línea)

➔ Filtro para bajas frecuencias
➔ Ajuste de ganancia de canal (preamplificador)
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6. Grabación y edición. Preparación del equipo
● Mesa de mezclas. Canal de entrada

➔ Compresor (afecta a la dinámica de la señal)

➔ Control de ecualización frecuencias altas

➔ Control de ecualización frecuencias medias

➔ Control de ecualización frecuencias bajas

Polos Creativos 
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6. Grabación y edición. Preparación del equipo
● Mesa de mezclas. Canal de entrada

➔ Control de envío a AUX 1

➔ Botón envío Pre fader
➔ Control de envío a efectos (AUX 2)

➔ Control panóramico (L/R)

➔ Botón MUTE

Polos Creativos 
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6. Grabación y edición. Preparación del equipo
● Mesa de mezclas. Canal de entrada

➔ LED indicador de MUTE
➔ LED indicador de saturación de señal
➔ Botón SOLO

➔ FADER de canal

Polos Creativos 
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6. Grabación y edición. Preparación del equipo
● Mesa de mezclas. Canal de salida
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6. Grabación y edición. Preparación del equipo
● Mesa de mezclas. Canal de salida

➔ Selector de audio para auriculares
Envío entrada 2-TR/USB a salida principal
Control de nivel de auriculares

➔ LED indicador de MAIN-SOLO y LED indicador PFL

➔ Selector modo normal o ajuste de ganancia para 
el vúmetro (medidor de señal)

Polos Creativos 
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6. Grabación y edición. Preparación del equipo
● Mesa de mezclas. Canal de salida

➔ FADERs L/R para la salida ALT 3-4
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6. Grabación y edición. Preparación del equipo
● Mesa de mezclas. Canal de salida

➔ FADERs L/R para la salida principal
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6. Grabación y edición. Preparación del equipo
● Mesa de mezclas. Canal de salida

➔ LED indicador encendido
LED indicado alimentación fantasma

➔ Vúmetro (medidor de señal) de la salida 
principal

Polos Creativos 
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6. Grabación y edición. Ajuste de ganancia

Vamos a ajustar micrófono a micrófono la ganancia de 
canal para asegurar un nivel óptimo, que no sature y que 
no haga necesario amplificar en etapas posteriores 
introduciendo ruido en nuestro podcast.

1) Presionamos el Botón SOLO del canal correspondiente 
y activamos la opción PFL para el medidor de señal 
presionando el botón MODE.

Polos Creativos 
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6. Grabación y edición. Ajuste de ganancia

2) Comenzaremos a hablar al micrófono a la misma 
distancia y nivel que vayamos a mantener durante el 
podcast.

3) Ajustaremos la ganancia de canal de manera que los 
picos más altos iluminen el nivel 0 en el vúmetro de la 
mesa (que estará mostrando el nivel de la señal).

4) Repetimos el proceso en el resto de micrófonos.

Polos Creativos 
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6. Grabación y edición. Audacity

Audacity es una de las aplicaciones multiplataforma más 
difundidas para grabación y edición de audio. Se 
caracteriza por su facilidad de uso, compatibilidad con la 
mayoría de formatos, posibilidad de agregar efectos al 
sonido y su capacidad multipista.

Se distribuye bajo la licencia GPL y su sitio web oficial es: 
https://www.audacityteam.org/

Polos Creativos 
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6. Grabación y edición. Audacity

Audacity ofrece la posibilidad de abrir un proyecto 
anterior o crear uno nuevo.

Cada proyecto cuenta con diferentes pistas de sonido que 
contienen el audio que será editado.

Para añadir nuevos audios al proyecto hay que utilizar la 
opción Importar del menú Archivo, o bien, realizar una 
grabación. Cada audio se almacena en una pista que 
incluye un canal si el sonido es mono o dos canales si el 
sonido es estéreo.

Polos Creativos 
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6. Grabación y edición. Audacity

Al comenzar el proceso de grabación y /o edición hay que 
utilizar la opción Guardar proyecto del menú Archivo.

Dependiendo de la versión de Audacity con la que trabajemos 
podemos encontrarnos con dos posibilidades:

1)  El proyecto se almacena en un archivo con extensión AUP 
(Audacity Project) que contiene toda la información relativa 
a la edición de las pistas. Cuidado, sólo contiene la 
información de los ajustes, no los archivos con el sonido, 
para éstos se crea una carpeta específica por cada proyecto, 
nombre_data.

Polos Creativos 
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6. Grabación y edición. Audacity

2)El proyecto se almacena en un archivo con extensión 
aup3 (Audacity Project) que contiene toda la 
información relativa a la edición de las pistas y archivos 
de sonido que forman parte del proyecto.

Ojo, estos formatos son propios de Audacity, no son 
un formato de audio. Veremos como exportar a formato 
de audio más adelante.
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49



6. Grabación y edición. Audacity. Configuración

Dependiendo de la versión de Audacity que estemos 
utilizando ajustaremos la frecuencia de muestreo, la 
resolución y el número de canales desde el menú 
Editar→Preferencias→Configuración de audio, 
Editar→Preferencias→Calidad o 
Edit→Preferences→Quality
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6. Grabación y edición. Audacity. Interfaz

Herramientas y cabecera de pista
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6. Grabación y edición. Audacity. Ajuste de nivel

Para empezar a grabar se hace clic en el botón de grabar 
dentro de la barra de herramientas. Hay que procurar que el 
medidor de intensidad del micro no indique que entramos 
en zona de distorsión. Un nivel adecuado debe estar en el 
entorno de los -9dB (entre -12dB y -6dB). Un volumen más 
alto producirá distorsiones que luego no pueden corregirse 
en la edición y un nivel muy bajo hará necesario amplificar 
mucho la señal con la introducción de ruido. Ajustaremos 
los niveles modificando la ganancia del micrófono en el 
Control de volumen. La grabación debe hacerse en mono.
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6. Grabación y edición. Audacity. Ajuste de nivel
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6. Grabación y edición. Audacity. Grabación

Se puede interrumpir el proceso de grabación haciendo 
clic en el botón de pausa dentro de los controles 
principales del programa. Para finalizar la grabación 
haremos clic en el botón de stop dentro de los controles 
principales del programa. 

IMPORTANTE: Para realizar una edición de un audio es 
preciso haber finalizado la grabación (stop).
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6. Grabación y edición. Audacity. Edición

En esta parte del tutorial no existe una fórmula 
exacta, depende totalmente del audio grabado y del 
objetivo buscado.

En cada etapa de la edición es importante oír varias veces 
el audio e ir ajustando según se necesite. En caso de que 
no quede bien debemos volver a las configuraciones 
anteriores usando CTRL + Z y repetir este proceso hasta 
obtener un resultado satisfactorio.
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6. Grabación y edición. Audacity. Edición

De manera genérica debemos editar y mejorar nuestro 
audio con los siguientes ajustes:

● Ecualización.
● Compresión.
● Amplificación (no debería ser necesario)
● Reducción de ruido (puede no ser necesario)
● Normalizar / Limitar (puede no ser necesario)
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6. Grabación y edición. Audacity. Edición

Vamos a ver unos ajustes guía que con pocas 
modificaciones (o ninguna) pueden servirnos para nuestro 
podcast.

GRABACIÓN ORIGINAL

Polos Creativos 

59


30.041035



6. Grabación y edición. Audacity. Edición

Ecualización. Primero seleccionamos toda la pista CTRL + 
A y después Efecto→Ecualizador gráfico o 
Effect→Equalization y escoger la opción Graphic.
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6. Grabación y edición. Audacity. Edición

Compresión. La voz humana tiene muchas variaciones en 
la intensidad (dinámica) comprimir las voces iguala las 
dinámicas y de esta forma se obtiene un mayor cuerpo 
en la voz o pegada. Este paso se hace aún mas necesario 
si grabamos a varios micros con varias voces distintas.

Primero seleccionamos toda la pista CTRL + A y después 
Efecto→Compresor o Effect→Compressor.
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6. Grabación y edición. Audacity. Edición

Amplificación. Si hemos ajustado correctamente los 
niveles de grabación es un paso innecesario. Primero 
seleccionamos toda la pista CTRL + A y después 
Efecto→Amplificar o Effect→Amplify.
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6. Grabación y edición. Audacity. Edición

Reducción de Ruido. Si notamos que queda un ruido de 
fondo al grabar y editar las voces producto del ambiente o 
del ruido estático del micro podemos intentar eliminarlo o 
minimizarlo con un filtro anti ruido.

En primer lugar seleccionamos una sección de la pista 
grabada en la que no haya voz, que sea sólo ruido. Con 
esta selección el programa tomará una referencia del 
ruido y lo podrá diferenciar de la voz. 
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6. Grabación y edición. Audacity. Edición

Reducción de Ruido.

Con la zona seleccionada iremos a  Efecto→Reducción 
de Ruido o Effect→Noise Reduction y haremos clic en 
la opción Obtener perfil de ruido (Get Noise Profile).
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 GRAB.     EQ.  COMP.  RUIDO

6. Grabación y edición. Audacity. Edición

Reducción de Ruido.

Una vez obtenido el perfil de ruido seleccionamos toda la 
pista CTRL + A y después Efecto→Reducción de 
Ruido. Podemos utilizar los valores por defecto.
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6. Grabación y edición. Audacity. Edición

Normalizar / Limitar.

La normalización de audio consiste en aplicar una cantidad 
de ganancia a una grabación para llevar la amplitud de 
pico promedio a un nivel objetivo, se trata de aumentar al 
máximo todos los picos de audio sin perder calidad.

Es útil cuando tenemos distintas grabaciones para 
conseguir que todas las pistas tengan un volumen similar.

Primero seleccionamos toda la pista CTRL + A y después 
Efecto→Normalizar o Effect→Normalize.

Polos Creativos 

72



Polos Creativos 

73



6. Grabación y edición. Audacity. Edición

Normalizar / Limitar.

Si hemos ajustado correctamente todos los valores de 
grabación/edición ningún pico debería saturar nuestra 
señal. Para asegurarnos de que esto no ocurra en nuestro 
podcast podemos aplicar un limitador que hace 
justamente esto. 

Primero seleccionamos toda la pista CTRL + A y después 
Efecto→Limitador o Effect→Plug-in 1 to 15→Limiter y 
dejamos los valores por defecto.
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6. Grabación y edición. Audacity. Edición

Otros efectos:

● Cambiar ritmo: (Change Tempo) modifica la velocidad de la 
grabación pero sin cambiar el tono.

● Aparecer Progresivamente: (Fade in) modifica el volumen 
de la zona de pista seleccionada de manera gradual 
ascendente desde cero.

● Truncar silencios: (Truncate Silence) En una grabación de 
voz pueden aparecer silencios prolongados. Este efecto 
reduce estos silencios a una duración determinada
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6. Grabación y edición. Audacity. Edición

Otros efectos:

● Desvanecer Progresivamente: (Fade out) modifica 
el volumen de la zona de pista seleccionada de manera 
gradual descendente hasta cero.

● Reverberación: (Reverb) es parecida al eco pero en la 
reverberación el oído percibe las distintas señales las 
recibe como una única. Nos permite simular estar en 
una sala más grande (iglesia).
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6. Grabación y edición. Audacity. Música de fondo y 
efectos.

Es más que probable que quieras usar varias pistas para 
edición con efectos, voces, música... sólo tienes que ir al 
menú Archivo→Importar→Audio.

Previamente tendremos que tener nuestra música o 
efectos descargados y localizados en nuestro equipo, para 
ello puedes utilizar los siguientes recursos:
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6. Grabación y edición. Audacity. Música de fondo y 
efectos.

● Procomún
● Audionautix
● Incompetech
● Scott Buckley
● Biblioteca de audio YouTube
● Mus Open
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6. Grabación y edición. Audacity. Música de fondo y 
efectos.

Si queremos usar una música de fondo es muy útil utilizar 
el Efecto→Auto Duck o Effect→Auto Duck ya que la 
pista donde se aplica este efecto baja su volumen cuando 
detecta sonido en la pista inferior.

Resulta muy útil para bajar la música de fondo (pista 
superior) cada vez que habla el locutor (pista inferior).

En primer lugar ajustaremos la duración de la/las pistas 
musicales a las del podcast.
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6. Grabación y edición. Audacity. Música de fondo y 
efectos.

Una vez hecho esto seleccionaremos la pista musical y 
después aplicaremos Auto Duck, podemos dejar los 
valores por defecto.
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6. Grabación y edición. Audacity. Exportar.

Una vez finalizado un proyecto con Audacity será 
necesario exportarlo en algún formato de audio. Para ello 
seleccionamos Archivo→Exportar audio (File→Export) 
o utilizamos la combinación CTRL + SHIFT + E. En la 
ventana emergente que aparece vamos a poder 
seleccionar entre distintos formatos de audio, las 
configuraciones de los mismos así como editar los 
metadatos del archivo resultante.
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6. Grabación y edición. Audacity. Exportar.

Veamos algunos de los formatos que podemos usar:
● MP3. Es aceptado en todas partes y compatible con 

todos los sitios a los que quieras subir tus audios. Para 
un podcast en MP3 se recomienda que el bitrate se 
mantenga entre los 128 y 160 kbps.

● AAC/M4A. Consigue archivos de menor tamaño y 
mejor calidad que los tradicionales MP3. Por este 
motivo hay quienes lo consideran su digno sucesor.
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6. Grabación y edición. Audacity. Exportar.

Veamos algunos de los formatos que podemos usar:
● FLAC. Posiblemente será el formato estándar de los 

podcasts del futuro. Es el más parecido al MP3, pero 
con la diferencia de que el FLAC no contiene pérdida de 
calidad sonora, a pesar de ser audio comprimido.

No conviene olvidar de revisar los metadatos antes de 
exportar nuestro podcast.
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7. Radio en directo

Si en lugar de un podcast grabado y editado lo que nos 
planteamos es realizar una emisión de radio en directo 
toda la edición debemos realizarla con la propia mesa. Al 
igual que cuando realizamos una postproducción del 
audio grabado no existe una fórmula mágica e infalible de 
que ajustes a realizar, pero como guía podemos 
plantearnos los siguientes:
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7. Radio en directo
● Utilizar el filtro de corte para bajas frecuencias.
● Ajustar la ganancia del canal como ya sabemos hacer.
● Comprimir la señal de voz (girar el potenciómetro hasta 

que el LED asociado empiece a iluminarse).
● Utilizar el ecualizador de manera muy sutil, se trata de 

un proceso de prueba y error, podemos probar a 
realzar suavemente las bajas y altas frecuencias y 
comprobar el resultado.
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7. Radio en directo

Es importante realizar estos ajustes para cada canal 
independientemente, para ellos debemos valernos de la 
función SOLO.

Además, si incluimos música de fondo tendremos que 
estar atentos y atenuar el canal de entrada utilizando el 
fader cuando los locutores estén hablando (una suerte de 
Auto Duck manual).
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8. Errores frecuentes
● No llega sonido de uno de los micrófonos a la grabación

➔ Comprobar si está “muteado” y bien conectado
➔ Comprobar si el fader de canal está levantado
➔ Comprobar si los fader de la mezcla principal están 

levantados
● No se escucha el audio de uno o varios de los canales

➔ Comprobar si algún canal está activado el SOLO
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8. Errores frecuentes
● No funcionan los auriculares.

➔ Revisar la posición del potenciómetro PHONES
➔ Revisar que estén conectados en la salida PHONES

● No funcionan los auriculares de los locutores
➔ Comprobar que el distribuidor de audio de los 

auriculares tiene corriente
➔ Comprobar la posición del mando de volumen del 

distribuidor de audio de los auriculares
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9. Webgrafía.
● https://www.xataka.com/basics/como-crear-tu-podcast-mejores-aplicaciones-para-grabarlos-edi

tarlos-subirlos

● https://abismofm.com/10-grandes-consejos-para-hacer-un-podcast-de-exito/

● https://abismofm.com/hacer-un-podcast-educativo/

● https://www.rdstation.com/blog/es/que-es-un-podcast/

● https://liberaturadio.org/audacity-editar-voces-podcast/#:~:text=Abre%20Audacity%20y%20ac
tiva%20el,mucho%20la%20se%C3%B1al%20con%20la

● https://www.ivanpatxi.es/formatos-de-audio-y-recomendaciones-para-tu-podcast

● https://es.wikipedia.org/wiki/Frecuencia_de_muestreo

● https://pixabay.com/es/

● https://audionautix.com/free-music/acoustic
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